OUtIOOk Web App ‘ NEOMIN Introduction

What is Outlook Web App (OWA)?

Outlook Web App, which will be more commonly
referred to as OWA, is a secure Microsoft WebMail
product that allows you to read your email from any
computer with an Internet connection.

https://exchange.neomin.org



https:///

OUtIOOk Web App ‘ NEOMIN Introduction

Overview

Overview

« School districts will begin migrating to OWA
(along with the standard Microsoft Exchange
Server) in the 2010/2011 school year.

interface in Microsoft Outlook. If you have used
Outlook, OWA should be very comfortable.
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« The web interface of OWA resembles the
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Overview

Logging Into OWA

 There are 2 security options when logging into OWA.:

- Public Computer: this options does not cache any of your login information
or emails. You will not be able to save email attachments via this option.

- Private Computer: this option will remember your email address and cache
some information. Email attachments can be save via this option.

» Please remember to use your full email address, not

just your username when logging into OWA.
q « Once logged in you can change your password from

the OWA interface. You can also set your vacation
notice from within OWA.

neouﬁ/nc
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- Logging Into OWA: Two interfaces to choose from!
Overview
ey .

. “Premium” interface - comes closest to
replicating the actual Microsoft Office Outlook
experience, with some right-click functionality
and access to the full feature set.

. “Light” interface - you receive the Light

interface when you are not using one of the
browsers or browser versions listed for the
premium interface, or you have enabled the

"Blind and low vision experience" option in OWA.

neouﬁ/nc
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L— Requirements for “Premium” Interface:

Internet Explorer 7 and above, FireFox 3 and
above, Safari 3 on a Mac, and Google Chrome 5
and above.

« If your web browser meets the requirements
above, “Premium” will display as the default
interface.

neorrﬁj
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Overview

Features missing from “Light” Interface:

The Tasks module
» Task-specific properties: Only the text of the task items can be read
through OWA Light.
* Reminders
« HTML composing of messages: OWA Light users get only plain text
textboxes with no editing or formatting options.
* Flags and Categories
* Monthly or weekly view in Calendar: OWA Light shows the daily view only.
» Free/Busy grid in Appointment/Meeting Scheduling Assistant: OWA Light
users get only "Suggested Times".
*  Print
» Spell Check
« Conversation View
» Account Quota information
* Recover Deleted Items
* Add/edit distribution lists
 Public Folder access rr{/“
« S/MIME features neo \p/

+ Add/edit rules
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, Can also choose “Light” mode at login if
Overview .
you prefer to use that version:




OUtIOOk Web App ‘ Working with Messages

Two different mail interfaces:

icrosoft

b

A '
4 = Favorites
=y L X Lol
L2 Unread Mail [ 1
If you selected =3 sent Items
the “Light”
interface. If you are using the
default, “Premium”
Interface.

neorry/ﬁ
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The remaining presentation
will focus on the
“Premium” interface.
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Folder View (shows contents of current folder):

4 | Favorites

5 A Mew Move ilter View ;
L—| Inbox (2

L0 unread Mail l?—/ 2 -9
=7 Sent Items Arrange by: Date - r MNeweston Top =

Enter aterm to search within
folders or subfolders.

neorrﬂ
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=

Outlook Web App

4 | Favorites
-] Inbox (2
L& Unread Mail (2
= Sent Items

Create a new
message

Filter View

Arrang® ay: Date - MewestonTop -
T

bl X Refresh / Retrieve
3 Message new messag es

:I Meeting Request

w\/
Mave

A2 Move to Folder,.,

|
[ Copy to Folder... HCO@
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View (toggling the reading pane):

Outlook' Web App

4 L2 Favorites
L] Inbox (2

LA Unread Mail (2
= Sent Items

2-column vs. |

3-column view [ 2

neorrﬁj
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2-Column View:

h Messages

Autumn Roper ~

s 52 Favorites
| Tnbox (7
2 Unread Mail (2
=] Sent Ttems

Autumn Roper

- Mail

] calendar
k&2 contaces
/] Tasks

=9 Public Folders

box

v,

range by: Date

ROBISON, COLRTNEY
RE: Verizon Netbook
ServiceDesk
Request 1391119 status changed to: Work In Progress
Kohis.com
Your Shopping Pass Is Here! Save UpTo 20%

: PMDF Internet Messaging
Undeliverable: Instance MIN Automatic Patron Updates

farum@oecn.k12.0h.us

Notification of new entries in “INFOHio".

genevieve,gglotti@neonin,org

Re: eSIs Transition - Library Patron Updates
. vrs. Karen Trukovich

Re: ““Introducng Cat  2.0%%

Autumn Roper

*Introdudng CatJr 2.0%%
i Tia Symeheck

Re: marming

INFOhio Suppart

Enabling new features of Symphany 3.3.1

Home Improvement - BHG. com

Simple End-of-Summer Projects

Garden Notes -BHG.com

Simple Ways to Enjoy the Summer Outdoars
i Tia Symcheck

morning

No
Reading
Pane

Options

£} @

Filter View 2
s -
NewestonTop =
g:514M
8126 M
5223400

5:06 AM

Thu 4:08 PM
Thu 2:31PM
Thu 2:28 PM
Thu 1:38 PM
Thu 11:54 AM
Thu 11:22 AM
Thu 10:58 AM
Thu 10:54 AM

Thu 10:23 AM

Nneori
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3-Column View:

Autumn Roper -

6§{Iook'WebApp

Options [

4 G2 Favorites 5 Ne X v Mo Flter = viey c Y N ‘
() Inboxc (2 rat —. & =
4 Unread Mail (2 -1
M a I I =3 sent Items rrange by: Date - Newest on Top Request 1391119 status changed to: Work In Progress

~ ServiceDesk [helpdesk@usd oecn k12 oh.us]
Autumn Roper
J ROBISON, COURTNEY 9:51 AM Sent: Friday, August 06, 2010 8:23 AM

RE: Verizon Netbook To: Autumn Roper

ServiceDesk 8:26 AM
Request 1391119 status changed to: Work In Progress

4 Kohls.com 5:23 AM

Your Shopping Pass Is Here! Save Up To 20%

P t [ ]
Modified By: Shutt, Terri
% PMDF Internet Messaging 5105 AM Assigned to: Shutt, Terri
Undeliverable: Instance MIN Automatic Patron Updates Group: INFOHIO.SIRST

**#This is an automated message, please do not zeply to this message***

L

affected End User: Roper, Autumn

Request Area: INFOHIQ.SIRSI.PATRONS

forum @oecn kiZ.oh.us Thy 4:03 PM Priority: None
v Open Date/Time: 08/04/2010 11:35:33
genevieve.giglotti@neomin.org Thu2:31PM L. i
Re: e515 Transition - Library Patron Updates A summary description of the reguest is:
Mrs. Karen Trkovich Thu2:28PM
Rutumn Roper - NEOMIN - Exp. Date = NEVER
. Thu 1:38PM 1 . . . . .
Hlnt You can Information associated with this status change is:
Thu 1154 AM

Status changed from 'Open' to 'Work In Progress'.

L resize @ column [ fos coiees seccripion o the somest o

i 9 b Iacin the Th 10:58 AM Instance BAD Port 7160.
o= ¢ yp g
Thu 10:54 AM Zm going to run the OHremovepatrons.sh script to remove expired students (with
] 1 th default 20100701 date). I logged into the instance and alsc ran the User List
IIIOUSG On e Thu 10:23 AM report. Once with the Before July 1, 2010 date and then a second time indicating a
=L BB date of NEVER, I got 32 pocec of ucorc wiih NEVER oo tholil oxp. dato,
] = EEEEEEEEE TR

line between
each column.

Nneori
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Will see these buttons on
3-Column View...

Outlook' Web App

4 52 Favorites 2 Mew ve Filter = View ; | N \
L] Inbox (2 y —E e =
& unread Mail (2 i
= Sent Items Arrange by: Date ~ MewestonTop -

| k] |
& S

q e
| Reply Reply All Forward

neorrﬂ
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Arrange by: Conversation:
Outlook' Web App

4 L2 Favorites

LA Unread Mail (2
= Sent Items

E-mails with the same Subject
can be grouped in the same
conversation. |

neorry/ﬁ
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Arrange by: Conversation:

All emails with the
same subject line,
from that day, will be
grouped together.

Arrange by:

[ INFOhi
Charles

P Cat Ir.

= A

& Martir

= Aurfie

a Mair tin

=4 A

& Mar tin

= A

(7 Old Che

neorry/ﬁ
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Toolbar buttons:

Untitled Message - Mozil
" i https://exchange.neomin.org/owa/?ae=Itern8lia= New&it=IPM.Motedicc= MTQuMC42MzkuM|EsZWAVYMsh
=isend [H| 0 @ 8 ¢ & (]| [3optons.. |[HM v (7]

Subject:

Tahoma

i [F% & H
Attach  Address Check Importance: Importance: Insert
File book Names High Low Signature

neorrﬁj
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Insert Signature button:

When you create a new message, add your signature
to it by clicking Insert Signature on the toolbar.

NOTE: You need to first create the signature file on
the main OWA screen > Options > Settings > Malil

Bﬁ{'look'WebApp ﬁ_ltc:maﬁcally include my signature on messages I send

o X You can also set the Signhature

file to automatically be

= included in each email...

Elock or Allow . é neorr\@\
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Check Names button:

@ Untitled Message - Mozilla Firefox | (B -

L Mhnp Y ehangeneomin.ong/owa/Tae= temBiaz Newsit=1PM.NoteBice=MTQuMCA 2 MakuMESZWAtYVWSh
T B B
) Mae than one match was found,

Brendakrol [Bres ~ T

—— | sumGbon 1.Type a few letters
==t 2. Click the “Check
Names” button to view a

list of names from the

Global Address Book. -
neomin/
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Setting Message Options (per Email):

@ Untitled Message - Mozilla Firefox

o | B X

Mai

|

.M https://exchange.neomin.org/owa 7ae=ltem&ta= New8it=1PM.Note&cc=MTQuMCA2MzkuMEsZWAEVMsh

IO i S
ETo...
Cc...
! Message Options X
Subject:
Tahoma Current Message Settings
Importance Mormal
Sensitivity Mormal -
Show Bec
Show From
Tracking Options
Request a delivery receipt for this message
Request a read receipt for this message
More Message Options
_J Click the Mail tab in Options for more message options.
ok | |igese)
Don

Importance
°Low
*Normal
*High

*Sensitivity
*Normal
*Personal
*Private
*Confidential

Show Bcc
*Show From

neorrﬁj
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Setting Message Options (per Email):

@ Untitled Message - Mozilla Firefox

o | B X

.M https://exchange.neomin.org/owa 7ae=ltem&ta= New8it=1PM.Note&cc=MTQuMCA2MzkuMEsZWAEVMsh

ETo...
[ Ce...
Subject:

Message Options

Tahoma Current Message Settings

Importance Mormal

Sensitivity Mormal -
Show Bec
Show From

Tracking Options

Request a delivery receipt for this message

Request a read receipt for this message

HMore Message Options

_J Click the Mail tab in Options for more message options.

OK

@

*Tracking Options
*Request delivery
receipt
*Request red receipt

neorrﬁj
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Change Settings under Options to:
* Preset your message format
« Change your email password

* Check spelling before sending a message

’ l * Choose how your calendar should look
q neont.
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Preset your message format:

e e

Outlook Web App

» - Message format can be
Account ,_4 AB = - 2 g o) .
Crgarnize E-Mai M il pelling Caleéar G;ﬁal Regional Pas{:'t SEt fo r a I I message .

w

El

2 | — | From the main OWA
g Message Format .
- screen select Options >
Block or All

Always show From

Settings > Message

Compose messages in this format:  HTML -
.
Choose message font: Format Sect|on .
Tahoma v|lo v B I U A- | p—
Sample Text

nemrﬁj
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Change your email password:

Sign out
| w © i o

;;J Tell people you're on vacation

Shortcuts to other things you can do

ket 7 Forward your mail using Inbox rules

W

(':

H‘{h Change your password

Learn how to get Direct Push e-mail on your mobile phone

¥ &

Connect Outlook to this account

2

neouﬁ/nc
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Setting a vacation notice:

Sign out
i 2
ions (7]
: ! ;J Tell people you're on vacation

Shortcuts to other things you can do

ket 7 Forward your mail using Inbox rules

W

L.J Learn how to get Direct Push e-mail on your mobile phone

G__:’} Connect Outlook to this account
B chamevour s
q neontin
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Setting a vacation notice (continued):

Outlook Web App

i E 4  Sselect that you want to
send automatic replies,
e v s, and then create your
s '—| “Out of Office” automatic
email message.

Send a reply once to each sender inside my organization with the following messa

Tahoma vt v B I U & = TS EE W, A Q2 E 9@ B X

ATTENTION:
-9
Iam in Columbus today attending the INFOhio Technical Roundtable. Please contact NEOMIN is you need immediate assistance

Autumn

7] Send automatic reply messages to External Senders
Send replies orly to senders in my Contacts list
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Check spelling before sending a message:

rosoft

1 - @ 3
Acrount ‘ A .&3 j

Orgarize E-Mail Mail spelling Calendar

2 Groups
Phone Choose your speling options.

Block or Allew Ignore words in UPPERCASE
ﬁnore words with numbers
| Always check speling before sending

Use this dictionary to check spelling:

English (United States) »
neorrﬁj
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Choose how your calendar should look:

Outlook Web App

Calendar ; |J General Regional Password

Acr AB
Account e

| Options | (G2 @ £ J
Organize E-Mail

IMail Speliing

2 Settings Appearance

Choose how your calendar should look.

Block or Allow Show wark week as:
sun [¥] Mon [¥] Tue [¥] wed (@] Thu (] Fri sat
v i
Determine work week Setyour warking s
Start time: 8:00 AM  + in (GMT-05:00) Eastern Time (LS & Canada)
. Endtime: 400PM « in{(GMT-05:00) Eastern Time (US & Canada)
v'  Set working hours 4

Show week numbers in Month view

v' Show week numbers in Month I
Vi ew ‘ Show hours in:

15-minute increments
v" Show first day of week L—l/ & e nsenens

v Show hours in increments

neouﬁ/nc
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' OWA Calendar:

H m—

Calendar optons ) @

< 2010 > B aw X - Hshare Today | [Efipay [Efjwork wesk Hiwesk Hfmonth & 3
JJJJJJ b Mar <> Ju|y 2010
Apr May Sday  Mon day Tuesday Wednesday Thusday  Fo dey  seur day
[ A | sep 27 28 29 30 Jull 2 3
ot Mov  Dec

4 My Calendars

] calendar

1
Calendar = . : i« . . 5
Hint: Double-click the gray
- o = = heading to switch to “Day” view.

25 26 27 28 29 30 31

e
‘q neoﬁﬁj
|




OUtIOOk Web App ‘ Calendar

Toolbar Basics:

u Outlook Web App
endar
_(t 2010 = ' i I'-JE'.'. >< _j ;:ﬂ Share Toda ﬁDa-; ﬁ'{.'ork Week ﬁ'\'.'eek jlﬂontﬁ ,g;l
& |
v
Calendar
A 4 h 4

Navigate to
another year

)
| I et

1
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Appointments are commitments
that only you are required to attend.

‘ﬁ https://exchange.neomin.org/owa/Tae=ltem &a=Newlit=IPM.Appointment&fld=LgAAAADsx 32 fHVhNOBT.
Saveand Close | [[] | ¥ Y 3 B =4 |HTML -
! =

| ‘

I Appointment Scheduling Assistant

Calendar

Location:

<

Start time: Maon 8/9/2010 11:30 AM hd All day event

<

End time: Mon 8/3/2010 12:30 FM b

V| Reminder: | 15 minutes Show time as: Busy b Private

Tahoma w10 «w B I U = i= i £

U]
U]
&
)
I

neorrﬁj
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Appointment options:

@ Untitied Appaintment - MazilaFisfor” oy« |n the Subject box, type a brief
I%M https://exchange.neomin.org description of the appointment.
[Hsaveanddlose ] & B ¥

* Inthe Location box, type the

Scheduling Assistant location where the appointment
Subject: | occurs.
Location: ! . . .
Calendar > e Inthe Start time and End time lists,

L Starttime: f |Mon 8/5/2010 X"l select the appropriate dates and

End time: Mon &/59,2010 ¥ | 12: ti mes.

/| Reminder: | 15 minutes » Show tme as: | | Busy e ("] Private
Tahoma w0« B I E = EE EE ‘EE W . i v

neowﬁ/n?
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Appointment options:

In the Show time as list, select how you want your schedule 5%

i to appear for the duration of the appointment.

E’Ij Your selection (Busy, Free, Tentative, or Out of Office) is

App what others will see if they view your shared schedule.

Subject: [

Calendar Location:

Start time: Mon 8/3/2010 11:30 AM -’ Al vent

End time: Mon 8/3/2010 12:30 PM 4

J| Reminder: | 15 minutes w Show time as: Busy b Private

Tahoma # 0 « B I E = EE EE ‘EE B - é'

neowﬁ/n?
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' Apply a category:

H I saveandClose | ) | O v 3B G [ v

| 0 [ Blue Category _'
0 [ Green Category
Cat eg O r I eS h eI p O] |:| Orange Cateqgory

] |:| Purple Category

you organize 0 [Red catesony
|tem S | ] yo ur ' ] [] Yellow Category Click here to

. Manage Cateqgaries, name your
mailbox. ) i
categories.

Calendar

Each category is assigned a color and a name.

q 1.
‘ ‘ 2. You can apply a category to anything in your mailbox: a

message, a calendar item, a contact, or a task. Y{/“
IlCOl\p/

|



